
Škoda Fabia
CenCenníkník

Essence Selection

1.0 MPI 59 kW (80 k) 5° MP 15 330 15 850
1.0 TSI 70 kW (95 k) 5° MP 16 030 16 550
1.0 TSI 85 kW (116 k) 6° MP 16 330 16 850
1.0 TSI 85 kW (116 k) 7° AP DSG - 18 350
1.5 TSI 110 kW (150 k) 7° AP DSG - 20 090
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Základná výbava

Interiér Studio

Oceľové disky kolies 5,5J x 15" s krytmi Callisto (185/65 R15)

Zadné kotúčové brzdy (len pre 1.0 TSI 85kW )

ESC vrátane ABS, MSR, ASR, EDS, HBA, XDS

Airbag vodiča a spolujazdca, airbag spolujazdca s deaktiváciou

Hlavové airbagy a bočné airbagy vpredu

Front Assist – výstraha pred kolíziou a podpora núdzového brzdenia
a Pedestrian Monitor (ochrana chodcov)

ISOFIX a Toptether pre sedadlo spolujazdca

3. hlavová opierka vzadu

Lane Assist – asistent udržiavania v jazdnom pruhu

Driver Alert - asistent rozpoznania únavy

Easy Light Assist – svetelný senzor

Kontrola tlaku v pneumatikách

LED hlavné svetlomety + LED denné svietenie

Predné hmlové svetlomety

Centrálne zamykanie s diaľkovým ovládaním (2 sklopné kľúče)

Infotainment Škoda s 8" dotykovým displejom

4 reproduktory vpredu

DAB – digitálny rádiopríjem

Bluetooth

8" virtuálny kokpit

2-ramenný PUR volant

Parkovacie senzory vzadu

Elektricky nastaviteľné a vyhrievané vonkajšie spätné zrkadlá,
lakované vo farbe karosérie

Elektrické ovládanie okien vpredu

Obmedzovač rýchlosti

Manuálna klimatizácia

Funkčný paket: 3 stropné madlá (zadné s háčikmi), slnečné clony
s Make-up zrkadlom na strane vodiča a spolujazdca, schránka
na okuliare, lampičky na čítanie vpredu a vzadu

Zadné sedadlá nedelené, zadné operadlá delené a sklopné v pomere
60:40

Tyre Fit – súprava na opravu pneumatík

e-Call - tiesňové volanie

Predĺžená záruka na 5 rokov/100 000 km

ŠKODA – Doživotná Garancia Mobility Premium - Poskytuje pomoc
servisným vozidlom na mieste poruchy (porucha na vozidle,
chýbajúce PHM, defekt pneumatiky, zabuchnuté/stratené kľúče,
vybitá batéria, zámena paliva), odtiahnutie vozidla, prípadne služby –
náhradnú dopravu, požičanie náhradného vozidla, ubytovanie
pre posádku a i.

Čítanie dopravných značiek

Interiér Loft

Poťah prístrojovej dosky Látka Kota Grey

Disky Proxima z ľahkej zliatiny 6J × 16" – strieborné (iba
pre 1.5 TSI 110 kW)

Zadné kotúčové brzdy (iba pre 1.5 TSI 110 kW)

Full LED zadné svetlá

Asistent rozjazdu do kopca

Easy Start - centrálne zamykanie s diaľkovým ovládaním
a štartovaním tlačidlom, bez Safe systému

2 reproduktory vzadu

Bezdrôtový Smartlink

2-ramenný kožený multifunkčný volant

Výškovo nastaviteľné sedadlo vodiča

Tempomat s obmedzovačom rýchlosti

Úložné vrecká na zadnej strane operadiel predných sedadiel

Dáždnik vo výplni dverí vodiča

Chrómované ovládače prívodu vzduchu a rámčeky prívodu vzduchu
v interiéri

Essence

Selection (navyše oproti Essence)
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Doplnková výbava

Assisted Drive › Adaptívny tempomat do 210 km/h
› Adaptive Lane Assist - adaptívne vedenie v pruhu
(nie je možné pre 1.0 MPI 59 kW)

PUE − 406

Assisted Drive Plus › Navyše oproti Assited Drive:
› Side Assist
› Vnútorné spätné zrkadlo s automatickým stmavovaním
› Elektricky sklopné vonkajšie spätné zrkadlá
› Light and Rain Assist - svetelný a dažďový senzor
› Predné hmlové svetlomety s funkciou corner
(nie je možné pre 1.0 MPI 59 kW)

PUF − 1024

Assisted Drive Premium › Navyše oproti Assited Drive Plus:
› Full LED predné svetlomety s LED denným svietením a LED corner

funkciou
(nie je možné pre 1.0 MPI 59 kW)

PU3 − 1597

Light & View › Vnútorné spätné zrkadlo s automatickým stmavovaním
› Elektricky sklopné vonkajšie spätné zrkadlá
› Light and Rain Assist - svetelný a dažďový senzor
› Predné hmlové svetlomety s funkciou corner

PUM − 359

Light & View Plus › Navyše oproti Light&View:
› Full LED predné svetlomety s LED denným svietením a LED corner

funkciou

PUN − 973

Safety paket › Kolenný airbag
› Bočné airbagy vzadu

PE4 458 458

Asistent rozjadu do kopca UG1 82 •

Essence SelectionBezpečnosť
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Transport › Cargo Elementy
› Multifunkčná kapsa so zadným platom
› Sieťový program
› Obojstranný koberec v batožinovom priestore (guma/látka)

PUP 109 109

Transport s dvojitou podlahou › Cargo Elementy
› Multifunkčná kapsa so zadným platom
› Sieťový program
› Obojstranný koberec v batožinovom priestore (guma/látka)
(možné len s 3GD)

PUQ − 94

Family › Odpadkový kôš
› Odkladací priestor s flexibilným držiakom na zadnom tuneli
› Lakťová opierka vzadu
› Držiak na tablet

PUR − 134

Paket na zlé cesty (nie je možné s 17"/18" diskami kolies a pre motorizáciu 1.5 TSI 110kW) PK4 195 195

Výsuvné integrované ostrekovače svetlometov, ukazovateľ hladiny kvapaliny v nádobe na ostrekovače PK5 158 158

Príprava pre ťažné zariadenie (nie je možné s WC2) PTX − 116

Ťažné zariadenie – odnímateľné (nie je možné s WC2) PTZ − 522

Ťažné zariadenie – odnímateľné s adaptérom (nie je možné s WC2) PTY − 560

Fajčiarsky paket (popolník vpredu a zapaľovač) 9JD 29 29

Dvojitá podlaha v batožinovom priestore (možné len s PUQ) 3GD − 146

Športový podvozok PSP − 143

Lodge › Látkové sedadlá Lodge
› Ambietné osvetlenie prepínateľné biela/červená
› Poťah prístrojovej dosky Látka Nuba Grey s prešívaním
› Chrómové orámovanie výduchov ventilácie
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› 4 LED lampičky na čítanie
› Výškovo nastaviteľné sedadlo spolujazdca
› Manuálne nastaviteľné bedrové opierky
› Elektrické ovládanie okien vzadu

WQ3 − 608

Suite › Látkové sedadlá Lodge s prvkami Copper
› Ambietné osvetlenie prepínateľné biela/červená
› Poťah prístrojovej dosky Látka Nuba Copper s prešívaním
› Chrómové orámovanie výduchov ventilácie
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› 4 LED lampičky na čítanie
› Výškovo nastaviteľné sedadlo spolujazdca
› Manuálne nastaviteľné bedrové opierky
› Elektrické ovládanie okien vzadu

WQ6 − 608

Essence SelectionFunkčnosť

Essence SelectionVolanty / interiéry / sedadlá
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Dynamic › Športové látkové sedadlá
› Poťah prístrojovej dosky Látka Dynamic
› Ozdobné kryty pedálov z ušľachtilej ocele
› Vkladané tkané koberce vpredu a vzadu
› 3-ramenný športový kožený multifunkčný volant
› Chrómové orámovanie výduchov ventilácie
› Výškovo nastaviteľné sedadlo spolujazdca
› Manuálne nastaviteľné bedrové opierky
› Elektrické ovládanie okien vzadu

WQ8 − 740

2-ramenný multifunkčný PUR volant PL0 141 −

2-ramenný kožený multifunkčný volant PLB 383 •

2-ramenný kožený multifunkčný volant s ovládaním DSG prevodovky PLC − 99

2-ramenný vyhrievaný kožený multifunkčný volant (možné len s PHB/PUH/PUI) PLD − 106

2-ramenný vyhrievaný kožený multifunkčný volant s ovládaním DSG prevodovky (možné len s PHB/PUH/
PUI)

PLE − 180

3-ramenný športový kožený multifunkčný volant PLF − 95

3-ramenný športový kožený multifunkčný volant s ovládaním DSG prevodovky PLG − 226

3-ramenný športový vyhrievaný kožený multifunkčný volant (možné len s PHB/PUH/PUI) PLH − 200

3-ramenný športový vyhrievaný kožený multifunkčný volant s ovládaním DSG prevodovky (možné len
s PHB/PUH/PUI)

PLI − 275

Disky z ľahkej zliatiny Rotare 5,5J x 15" s Aero krytmi - strieborné (pneu 185/65 R15) PJ2 600 600

Disky z ľahkej zliatiny Rotare 5,5J x 15" s Aero krytmi - čierne lesklé (pneu 185/65 R15) PJ3 − 712

Disky z ľahkej zliatiny Proxima 6J x 16" - strieborné (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ4 1063 1063 / •

Disky z ľahkej zliatiny Proxima Aero 6J x 16" - čierne lesklé (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ5 − 1229 / 167

Disky z ľahkej zliatiny Proxima Aero 6J x 16" - sivé (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ6 − 1229 / 167

Disky z ľahkej zliatiny Ursus 6J x 16" - čierne (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ0 − 1331 / 268

Disky z ľahkej zliatiny Procyon 7J x 17" - strieborné (pneu 215/45 R17)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ7 − 1526/ 463

Disky z ľahkej zliatiny Procyon Aero 7J x 17" - čierne lesklé (pneu 215/45 R17)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ8 − 1690 / 627

Disky z ľahkej zliatiny Procyon Aero 7J x 17" - sivé (pneu 215/45 R17)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ9 − 1690 / 627

Disky z ľahkej zliatiny Libra 7J x 18" - čierne (pneu 215/40 R18) (nie je možné pre 1.0 MPI 59 kW)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJF − 2314/ 1251

Rezervné koleso (neplnohodnotné) pre 15" disky + zdvihák +klúč na kolesá PJA 129 129

Rezervné koleso (dojazdové) pre 16", 17" a 18" disky + zdvihák +klúč na kolesá PJB 129 129

Rezervné koleso (dojazdové) pre Sound Systém zdvihák +klúč na kolesá (iba s 9VJ) PJC − 129

Comfort › Vkladané tkané koberce vpredu a vzadu
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› Stredová konzola s držiakom na nápoje typu Snehuliak
› Výškovo nastaviteľné sedadlo vodiča
(nie je možné s 9JD)

PU0 206 −

Comfort Plus › Vkladané tkané koberce vpredu a vzadu
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› Stredová konzola s držiakom na nápoje typu Snehuliak
› Výškovo nastaviteľné predné sedadlá s manuálne nastaviteľnými

bedrovými opierkami
› Elektrické ovládanie okien vzadu
(nie je možné s WQ3/WQ6/WQ8)

PUV − 384

Essence SelectionVolanty / interiéry / sedadlá

Essence SelectionDisky / pneumatiky

Essence SelectionKomfort
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Park & Go › Zadná parkovacia kamera s ostrekovačom
› Drive Mode Select
› KESSY
› Predné parkovacie senzory
(nie je možné pre 1.0 MPI 59 kW)

PUA − 594

Park & Go Plus › Naviac oproti Park & Go:
› Park Assist – parkovací asistent
(nie je možné pre 1.0 MPI 59 kW)

PUC − 672

Park & Go (so Safe Systémom
a Alarmom)

› Zadná parkovacia kamera s ostrekovačom
› Drive Mode Select
› KESSY so Safe Systémom
› Alarm
› Predné parkovacie senzory
(nie je možné pre 1.0 MPI 59 kW)

PUB − 751

Park & Go Plus (so Safe
Systémom a Alarmom)

› Naviac oproti Park & Go:
› Park Assist – parkovací asistent
(nie je možné pre 1.0 MPI 59 kW)

PUD − 804

Parkovacie senzory vpredu 7X2 − 336

Parkovacia kamera s ostrekovačom KA1 − 289

Winter › Vyhrievané predné sedadlá
› Ukazovateľ stavu kvapaliny v ostrekovači
› Vyhrievané trysky ostrekovačov čelného skla

PUG − 221

Winter Plus › Naviac oproti Winter:
› Climatronic – dvojzónová automatická klimatizácia so senzorom

vlhkosti a kombi filtrom
› Vnútorné spätné zrkadlo s automatickým stmavovaním
(iba s PLD, PLE, PLH, PLI)

PUH − 482

Winter Premium › Naviac oproti Winter Plus:
› Vyhrievané čelné sklo
(iba s PLD, PLE, PLH, PLI)

PUI − 586

Chrome › Sunset – sklá s vyšším stupňom tónovania od B‑stĺpika
› Podokenná chrómová lišta
› Nástupné prahové lišty na prahoch dverí

PUJ − 244

Design › Naviac oproti Chrome:
› Disky z ľahkej zliatiny 16“ Ursus – čierne leštené
(možné len s YCA)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PB1 − 1158 / 426

Adaptive Cruise Control – adaptívny tempomat do 210 km/h (nie je možné pre 1.0 MPI 59 kW) PL2 − 299

Sunset – sklá s vyšším stupňom tónovania od B‑stĺpika 4KF − 158

Open Sky › Panoramatická strecha
› 4 stropné madlá
› bez schránky na okuliare
› bez skladacej slnečnej clony

WGS − 1093

Climatronic – dvojzónová automatická klimatizácia so senzorom vlhkosti a kombi filtrom PHB − 380

Technology › 2 reprodktory vzadu
› Bezdrôtový Smartlink

WUS 300 •

Navi paket › Škoda Navigation s 9,2" dotykovým displejom
› Virtuálny kokpit – 10" digitálny prístrojový panel s nastaviteľným

zobrazovaním údajov
› Hlasové ovládanie
› Infotainment online služby na 1 rok

WNA − 1237

Charging › Phonebox
› 2 x USB-C vzadu
› USB-C v držiaku vnútorného spätného zrkadla
(možné iba s WQ3/WQ6/WQ8/PUV)

PU2 − 286

Essence SelectionKomfort

Essence SelectionMultimédiá
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Virtuálny kokpit – 10" digitálny prístrojový panel s nastaviteľným zobrazovaním údajov 9S0 − 453

Sound Systém Škoda - Škoda Soundpaket so 6 reproduktormi a subwoofer, rezervné koleso (dojazdové)
pre Sound Systém zdvihák +klúč na kolesá (možné iba s WNA)

PJC − 617

Alarm PD1/PD3 250 250

KESSY- systém bezkľúčového odomykania, zamykania a štartovania s alarmom a systémom safe PD5 − 446

Modrá Energy *UNI 0 0

Biela Candy *SPE 350 350

Metalické farby *MET 526 526

Oranžová Phoenix, Červená Velvet *FLT 875 875

Chromová predná a zadná lišta nárazníka (možné len s PB1) YCA − 424

Color Concept Čierny -
nezahŕňa farbu vozidla

› Čierna strecha
› Čierne vonkajšie spätné zrkadlá
› Chrómované orámovanie prednej masky
(možné len s PJ5/PJ8)

WC1 − 238

Color Concept Sivý - nezahŕňa
farbu vozidla

› Sivá strecha
› Sivé vonkajšie spätné zrkadlá
› Sivé orámovanie prednej masky
(možné len s PJ6/PJ9)
(nie je možné s PTX/PTY/PTZ)

WC2 − 251

Predĺžená záruka na 5 rokov/100 000 km EA4 • •

Predĺžená záruka na 5 rokov/150 000 km EA9 198 198

Servis 5 rokov / 75 000 km 720 1374

Servis 5 rokov / 100 000 km 960 1944

Servis 5 rokov / 150 000 km 1464 3108

• Základná výbava − Nie je v ponuke MPManuálna prevodovka AP Automatická prevodovka

Poznámky

Essence SelectionMultimédiá

Essence SelectionZabezpečenie vozidla

Essence SelectionOstatné

Basic ProfessionalServisné balíčky

Technické dáta vozidla nájdete v katalógu technických dát na stránke www.skoda-auto.sk.
Ceny uvedené v cenníku sú odporúčané ceny pre klienta v € vrátane DPH.
Doplnková výbava znamená bohatšie vybavenie vozidla, nie zdvojenú výbavu. Konečnú cenu, výbavu a jej
možnú kombinovateľnosť konzultujte s autorizovaným predajcom značky Škoda.
Spoločnosť Škoda Auto Slovensko s. r. o. si vyhradzuje právo zmeny cien a špecifikácií
bez predchádzajúceho upozornenia. Všetky obrázky sú ilustračné.

Cenník platný od 02.01.2024 (MR2024)

Spoločnosť Škoda Auto sa usiluje o zodpovedný, trvale udržateľný vývoj spoločnosti a šetrný prístup k životu a prírode.

Váš autorizovaný partner značky Škoda
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